
Task 5 

Static deformation of a piezoceramic transducer with multi-electrode 

coating 

 

Objectives of the assignment:  

1. Study the main features of solving the problems of electroelasticity in 

ANSYS APDL: 

• setting the parameters of piezoelectric material 

• defining the element coordinate systems and using them to set anisotropic and 

piezoelectric properties of the material  

• using mapped finite element mesh 

• defining the electrode surfaces and setting the boundary conditions on them 

The example problem is a two-dimensional static problem for a piezoelectric 

transducer with inhomogeneous polarization and multielectrode covering. 

2. Write a program in ANSYS APDL for an individual assignment problem 

(static problem for a piezoelectric transducer with inhomogeneous polarization and 

multielectrode covering) 

3. Perform computations, analyze the results and prepare a report. 

 

 

Example problem 

The piezoelectric disk of the radius R and the thickness H is assumed to be in 

a state of axisymmetric deformation in a cylindrical coordinate system Orz (

Rr 0 , 2/2/ HzH − ). By virtue of axial symmetry, it is enough to consider 

only a meridional section of the disk. In accordance with ANSYS methodology, r is 

the X-axis, and z – is the Y-axis.  

The disk has four electrode surfaces (Fig. 1): electrode 1 is 10 RX  , 

2/HY −= ; electrode 2 is 10 RX  , 2/HY = ; electrode 3 is RXR 2 , 

2/HY −= ; electrode 4 is RXR 2 , 2/HY = . The disk is made of 

piezoceramics PZT-4. Two of its zones { 10 RX  , 2/2/ HYH − } and {

21 RXR  , 2/2/ HYH − } are polarized along the axis Y, and the zone {

RXR 2 , 2/2/ HYH − } is polarized opposite to the direction of the axis Y 

(Fig. 2). 

 
Fig. 1 Sketch of piezoelectric disk with four electrodes 
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Fig. 2 Meridional section of a piezoelectric disk 

 

The disk is fixed in Y direction in the middle points of its outer surface, i.e.. 

0=yU  при RX = , 0=Y , the symmetry conditions hold at 0=X , and the rest of 

the boundaries are free from mechanical stresses. 

The disk is deformed by the applied electric voltage to the electrodes. The 

boundary conditions are: inpV−=   on the first electrode, inpV=  on the second 

electrode, inpV−=  on the third electrode, and inpV=  on the forth electrode. 

The objective of the problem is to determine the displacements of the disk 

caused by its deformation.  

 

SOLVING THE PROBLEM USING ANSYS 

The example of problem solving using ANSYS is provided in the file 

Piezodisk_St.inp. The example of problem solving using ANSYS is provided in the 

file: Coupled-Field Guide, 2.14. Sample Piezoelectric Analysis (Batch or Command 

Method), 2.16. Sample Electroelastic Analysis of a Dielectric Elastomer (Batch or 

Command Method); Verification Manual, файлы Vm175.dat, Vm176.dat, 

Vm231.dat, Vm237.dat (ссылки приведены для ANSYS 11.0). 

ANSYS Product Launcher is the best option to start working with ANSYS. In 

ANSYS Product Launcher, select Simulation Environment→ANSYS, choose 

Working Directory for storing the working files and define Job Name for the project. 

If there is an existing ANSYS database, then after the launch of ANSYS it can 

be resumed from File→Resume. 

An ANSYS command file (text file with extension .inp, .dat or.txt), written in 

APDL ANSYS, can be executed from File → Read Input from… When creating a 

command file, it is useful to copy the commands from the input file into the 

command line, execute them step by step and look at the results in interactive mode. 

It is recommended to save results from time to time! The current database 

should be cleared before performing new analysis File→Clear and Start New. 

 

Definition of material constants for piezoelectric materials 

As it is known, the piezoelectric effect can be observed only in crystals that 

do not have the central symmetry. Therefore, the piezoelectric bodies must have 
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anisotropic properties. In a general case, in order to set the material constants of 

piezoelectric bodies in ANSYS, the following values should be defined: the density 

; the symmetric matrix of elastic moduli Ec  ; ,  = 1,…,6; EE cc  = ; the 

matrix of piezoelectric modules ie ; i = 1,2,3;  = 1,…,6; and the diagonal matrix 

of dielectric permittivities 
S
iiэ ; i = 1,2,3. (It is possible to set alternative sets of 

material moduli such as elastic compliances Es   and so on) 

Let us describe the method of defining the modules Ec   and ie  n ANSYS in 

more detail. The coefficients Ec   are set in a form of 6x6 matrix (4x4 for 2D 

problems). By virtue of symmetry, only the upper triangular part of the matrix of 

elastic moduli is used, and the coefficients of the matrix are arranged in a specific 

way: 
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where Ec   define elastic moduli in the theory of piezoelectricity. 

The components of the matrix DANSYS,3(2)c  in ANSYS are defined by the 

commands:: TB,ANISO,MAT and TBDATA,STLOC,C1,C2,…,C6; where MAT is 

the number of the material properties set, STLOC is the starting location in the data 

table for entering data values C1,C2,…,C6 in 1D array. The data table for the 

coefficients that enter in (1.1), (1.2), is filled by rows (1.1) in a form of one-

dimensional array with 21 components: 
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The resulting correspondence between the data from the data table defined by 

TBDATA, command and the elasticity moduli Ec  : 
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The most common type of piezoelectric materials is the piezoceramics 

polarized along the axis Oz, whose nonzero elastic moduli in TBDATA data table 

will have the following numbers: (for piezoceramic 
EE cc 1122 = ; 

EE cc 1323 = ; 
EE cc 4455 =

; 2/)( 121166
EEE ccc −= ) ): 

 

№ 1 2 3 7 8 12 16 19 21 
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As it can be seen from comparison of (1.1) – (1.3), for 2D problems it is enough 

to specify the first 16 positions in a one-dimensional array of the moduli Ec  . 

We note that for plane and axisymmetric 2D problems the plane Oxy is the 

working plane, and the axis Oy is usually considered to be the axis of polarization 

(axis z=(3) for the moduli Ec  ). In this case for plane and axisymmetric problems 

different nonzero elastic moduli for piezoceramics in the data table TBDATA will 

have the following numbers: 
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In a similar unusual way the piezomoduli ie  are set in ANSYS. The 

piezomoduli are arranged in a 6x3 (4x2 for 2D problems): 
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After the execution of the command TB,PIEZ,MAT the data table TBDATA for 

the piezomoduli will filled by rows with the values from the matrix ANSYS,3De  as 

a one-dimensional array of the size 18. As a result, we obtain the correspondence 

between the data from the data table TBDATA and the piezomoduli ie : 

 

№ 1 2 3 4 5 6 7 8 9 

ie  11e  21e  31e  12e  22e  32e  13e  23e  33e  

№ 10 11 12 13 14 15 16 17 18 

ie  16e  26e  36e  14e  24e  34e  15e  25e  35e  

 

where for 2D problems it is enough to define the elements with numbers 1, 2, 4, 5, 

7, 8, 10 and 11. 

For the piezoceramics polarized along the direction of the axis Oz, the nonzero 

piezomoduli of piezoceramic material for 3D problems in the data table TBDATA 

will have the following numbers (for piezoceramic 3132 ee = ; 1524 ee = ): 

 

№ 3 6 9 14 16 

ie , 

piezoceramic 

31e  31e  33e  15e  15e  

 

Finally, for plane and axisymmetric problems in the cases, when in the plane 

Oxy the axis Oy is the axis of preliminary polarization of piezoceramics, and 

different nonzero piezomoduli in the data table TBDATA will have the numbers  

that are indicated in the table: 

 

№ 2 5 8 10 

ie , 

piezoceramic 

31e  33e  31e  15e  

  

Summarizing the above, for the piezoceramic material we can write the 

following fragments of program code in ANSYS APDL, that define the sets of 

material constants MAT with number 1 for 3D and 2D problems, where for the latter 
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case the piezoceramics is considered to be polarized along the Oy-axis of the 

working plane Oxy: 

 

Fragment 1 (3D).    Fragment 2 (2D). 
MP,DENS,1,RHO    MP,DENS,1,RHO 

TB,ANEL,1     TB,ANEL,1 

TBDATA,1,C11E,C12E,C13E TBDATA,1,C11E,C13E,C12E 

TBDATA,7,C11E,C13E   TBDATA,7,C33E,C13E 

TBDATA,12,C33E    TBDATA,12,C11E 

TBDATA,16,C66E    TBDATA,16,C44E 

TBDATA,19,C44E    TB,PIEZ,1 

TBDATA,21,C44E    TBDATA,2,E31 

TB,PIEZ,1     TBDATA,5,E33 

TBDATA,3,E31    TBDATA,8,E31 

TBDATA,6,E31    TBDATA,10,E15 

TBDATA,9,E33    MP,PERX,1,EPS11 

TBDATA,14,E15    MP,PERY,1,EPS33 

TBDATA,16,E15 

MP,PERX,1,EPS11 

MP,PERZ,1,EPS33 

 

Here RHO=; C11E=
Ec11 and so on. These values are scalar parameters in 

ANSYS APDL and their values should be defined beforehand. Besides, in the 

presented fragment of the program code we have added MP command, that defines 

the density and the dielectric permittivities of piezoceramics. 

As it can be seen, the definition of piezoelectric materials requires some efforts. 

It should be emphasized that in the presented fragments the axes of Oxy(z)-plane  are 

the axes of the element coordinate systems for the defined constant sets. 

 

Let us now return to the listing of the input file for solving the test 2D static 

problem for piezoelectric transducer with inhomogeneous polarization and multi-

electrode coating. 

The command ET,1,PLANE223,1001,,1 defines the quadrilateral 8-node 

finite element PLANE223 with the options of piezoelectic analysis and 

axisymmetry. This element will be used to solve the problem. For ANSYS user all 

the distinctions between axisymmetric problem and 2D plane stress problem consist 

in the third option of this finite element (the command ET,1,PLANE223,1001,,0 

will define the element for 2D plane stress problem). However, with this option 

ANSYS will use the equations of axisymmetric theory of piezoelectricity that are 

much more complex than the equations of plane stress or plane strain. 

 

Solid model of the meridional section of piezoelectric disk 

In ANSYS APDL the solid model of the original domain with complex 

geometry is usually constructed from bottom to top', starting with the most simple 
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objects (Entities), which are the Keypoints, and finishing with Areas for 2D 

problems or Volumes for 3D problems. 

K command is used to build the keypoints. Its first argument is the reference 

number of the keypoint, and the remaining arguments are the coordinates of the 

keypoint. For example, K,2,R1,-H/2 command defines a keypoint with the reference 

number 2 and coordinates x=R1, y=-H/2, z=0 (the last coordinate takes the default 

value). The Line}between two keypoints can be defined by L command. For 

example, L,2,3 command defines a line in the active coordinate system between the 

keypoints 2 and 3. The lines are numbered automatically, starting with the lowest 

available number. In order to construct the areas, we can use the commands A and 

AL, where the resulting areas are also numbered automatically. AL command 

creates an area bounded by the previously defined lines. The lines (10 lines 

maximum) must be input in clockwise or counterclockwise order and must form a 

simply connected closed curve. A command defines an area by connecting the 

keypoints. The keypoints defining the area must be input in clockwise or 

counterclockwise order around the area (maximum 18 keypoints in the list). The 

existing lines between adjacent keypoints will be used; and the missing lines will be 

generated as straigh lines in the active coordinate system and will be assigned the 

lowest available numbers. 

According to Fig. 2, in the meridional section of the disk we can distinguish 

two zones with two different polarization directions. Therefore the axisymmetric 

model of the disk can be composed by two areas. Fig. 3 shows the areas A1 and A2 

with indicated area numbers and keypoint numbers (Menu path Plot->Areas, to show 

the numbers of areas and keypoints select PlotCtrls->Numbering-> tick Area 

numbers, Keypoint numbers) 

 
Fig. 3 Area numbering in the model of a meridional section of piezoelectric disk 

 

 
Fig. 4 Keypoints and meshed lines of the disk section model 
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The lines and the keypoints that constitute the areas A1 and A2 can be seen in 

Fig. 4 (Menu path: Plot->Lines (preliminary go to Select->Entities and select the 

lines L1-L9), show the numbers of lines and keypoints by selecting: PlotCtrls-

>Numbering->tick Line numbers, Keypoint numbers). Here a rectangular area A2 is 

constructed in a standard way of four lines L3, L4, L5, L9 and four keypoints 3, 4, 

5, 6. The upper and the lower boundaries of this area coincide with the lines of the 

electrodes location. The area A1 consists of six keypoints 1, 2, 3, 6, 7, 8 and six lines 

L1, L2, L9, L6, L7, L8. For this area both upper and lower boundaries must be 

constructed of two lines, and the keypoints of the lines L1 and L7 that simulate the 

electrodes must coincide with the ends of the electrodes. This requirement ensures 

that the ends of the electrodes will coincide with the nodes of finite elements. It is 

also worth noting, that the line L9 is common for the adjacent areas A1 and A2. 

 

Direction of the polarization vector for the areas of piezoelectric disk 

For plane and axisymmetric 2D problems it is convenient to consider the axis 

Oy as the axis of preliminary polarization in the working plane Oxy, and therefore 

in ANSYS for the piezomaterials with different polarization vectors it is enough to 

define for the corresponding areas the element coordinate systems that are rotated in 

the proper way with respect to the global coordinate system. 

 
Fig. 5 The directions of the polarization vectors P for the areas of the disk section 

 

For our example problem the direction of the polarization vector P in the area 

A1 coincides with the direction of the Oy-axis of the global Cartesian coordinate 

system, therefore for the finite elements of this area it is not necessary to introduce 

special coordinate system. For the area A2 the direction of the polarization vector P 

is opposite to the direction of the Oy-axis of the global Cartesian coordinate system, 

therefore for this area it is necessary to define the element coordinate system with 

the axis Oy’, directed along the polarization vector, i. e. the axis Oy’ must be directed 

in the way opposite to the axis Oy. 

To achieve this, we need to rotate the original element coordinate system to 

180 degrees with respect to the global Cartesian coordinate system. The next block 

of commands creates the local coordinate system and defines it as an element 

coordinate system for finite elements that will be created in the area A2. 

 

LOCAL,11,0,,,,180 

ASEL,S,AREA,,2 

AATT,1,,1,11 
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Fig. 6 shows an example of finite element mesh with the element coordinate 

systems (see green lines). To show finite element mesh, select Menu path:  

Plot -> Elements. To show polarization, select Menu path: Plot Ctrls -> Numbering-

>Elem/Attrib numbering-> select Element CS num, Numbering shown with Colors 

only, to show the direction of the element coordinate system for every element select 

PlotCtrls->Symbols, tick ESYS Element coordinate sys) 

  

 
Рис. 6 Element coordinate systems in the areas of meridional section of the disk: general view and 

zoomed region 
 

Finite element mapped mesh 

As the element PLANE223 is a quadrilateral finite element and the simulated 

area of the meridional section of the disk is a quadrangle, more precisely, rectangle, 

it is therefore logical to use mapped finite element meshing in quadrangles (or, even 

better, in rectangles). 

There are two main meshing methods in ANSYS: Free Mesh and Mapped 

Mesh. A free mesh does not follow any pattern and has no element shape restrictions. 

Free mesh is suitable for areas and volumes of complex shapes. Free mesh is usually 

defined by an average finite element size. On the contrary, a mapped mesh restricts 

the element shape (for example, quadrangles for areas, or hexahedrons for volumes) 

and typically has a regular pattern with obvious rows of elements. Mapped mesh is 

beneficial for areas and volumes of simple shape, such as rectangles or bricks. The 

use of a mapped mesh facilitates to reduce the computation time. Usually a mapped 

mesh is built on the base of the divisions and spacing ratio, which are specified for 

its constituting lines. Generally, a mapped mesh is more precise than a free mesh 

with comparable number of elements and nodes. 

In order to built a mapped quadrilateral finite element mesh for a quadrilateral 

area, this area must satisfy two conditions: 1) the area must consist of four lines, 2) 

the area must have equal numbers of element divisions specified on the opposite 

sides. If an area is bounded by more than four lines, then some of the lines can be 

combined (by LCOMB command) or concatenated (by LCCAT command) in order 

to reduce the total number of lines to four. 

In our example problem there are at least two ways to construct a solid model 

of the meridional section of the disk that would accept mapped finite element mesh. 

For example, we could build an additional line between keypoints 2 and 7 and then 

create three rectangular areas, each of them consisting of four lines. 

Here we use another way that allows us to reduce the number of the required 

areas to two. We create two areas A1 and A2, where A2 is a regular area that accepts 

a mapped mesh, and A1 is irregular in the way that it does not accept a mapped mesh 

because it consists of six lines. In order to make area A1 regular, it is enough to 
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concatenate lines L1 and L2 which constitute the lower boundary and lines L6 and 

L7 which constitute the upper boundary. This can be done by LCCAT, command 

which concatenates multiple, adjacent lines  into one line in preparation for mapped 

meshing. Note that LCCAT accepts only two arguments, so if it is necessary to 

concatenate more than two lines, the first argument should be set to ALL. In this 

case the second argument is ignored and all previously selected lines (by LSEL 

command) are concatenated. It is also worth noting that for a mapped mesh the total 

number of the line divisions must be the same for the opposite lines of the area. Fig.7 

shows the result of concatenation for the lines of the upper and lower boundaries of 

the area A1. The output lines L10 and L11 keep the element divisions of the input 

lines. 

 
Fig. 7 Line concatenation for a solid model of the meridional section of the disk 

 

Boundary conditions 

1) Boundary conditions on the electrode surfaces.  

In the theory of piezoelectricity the piezoelectric materials are considered to 

be active dielectrics. The parts of the boundary Vm ; m=1,2,…,M; can be 

represented by the metallized surfaces or electrodes. The electrodes Vm  are 

assumed to be equipotential surfaces, i. e. the electric potential (x,t) on these 

surfaces should not depend on the coordinate vector x: 

 )(tVm= ; Vmx     (2.1) 

The boundary conditions (2.1) are called essential or kinematic electric boundary 

conditions for the boundary-value problems of piezoelectricity, if )(tVm  are known 

functions. The electrodes with known )(tVm  are called the electrodes powered by 

voltage generators, and when 0=mV  they are called short-circuited grounded 

electrodes. 

The other type of electrodes are the electrodes Ql , powered by current 

generators lI . For the electrodes Ql ; l=1,2,…,L; the boundary conditions have the 

form: 

 )(tl= ; Qlx     (2.2) 

 lQd
Ql

=  ][Dn ; ll IQ =     

where n is the normal to Ql ; ][D  is the jump of the electric induction vector D; lQ  

is the total surface charge on the electrode Ql ; where the values of the electric 
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potentials )(tl  are initially unknown. When 0=lQ , the electrodes (2.2) are called 

open or passive electrodes. 

 Boundary conditions (2.1) and (2.2) can be implemented in ANSYS in the 

following way. The nodes of the finite element mesh that belong to one electrode 

Vm  or Ql can be combined in one node (coupled DOF) by CP command that will 

be a reference node for this electrode. Then for this reference node N_VOLT we can 

either set the value of the electric potential VM= mV  by the command 

D,N_VOLT,VOLT,VM, or define the total electric charge QL= lQ  by the command 

F,N_VOLT,CHRG,QJ (for finite elements PLANE223, SOLID226, SOLID227) 

or by the command F,N_VOLT,AMPS,QJ (for finite elements КЭ PLANE13, 

SOLID5, SOLID98). The block of commands, that define a group of nodes and set 

the value of the electric potential on the first electrode, is presented below: 

NSEL,S,LOC,Y,-H/2 

NSEL,R,LOC,X,0,R1 

CP,1,VOLT,ALL 

*GET,N_VOLT1,NODE,,NUM,MIN 

D,N_VOLT1,VOLT,-VINP 

In order to define a free electrode, it is enough to define a group of nodes by 

CP command with using D command. 

 

2) Mechanical boundary conditions. In our example problem we need to set 

the symmetry boundary conditions with respect to the axis of rotation Oy and the 

constraint on the displacements along Oy for the middle point on the outer surface 

radius of the meridional section of the disk. 

The degrees-of-freedom constraints (three DOFs UX, UY, VOLT for the 

element PLANE223 with the options of piezoelectric analysis KEYOPT(1) = 1001) 

can be set either by D command that defines DOF constraints at nodes or by DL 

command that defines DOF constraints on lines. It should be noted that all solid 

boundary conditions will be transformed into finite element boundary conditions at 

the stage of the solution. The solid boundary conditions set on lines have priority 

over the finite element boundary conditions for the nodes on the same line. 

2.1) The condition of symmetry can be set either by DL command or by D 

command. D command accepts a symmetry option SYMM, as in the above example 

DL,8,,SYMM. Another way is to select all necessary nodes and use D command. 

We can select the nodes that lie on the line L8 by the following commands: 

LSEL,S,LINE,,8 

NSLL,S,1 ! Select nodes belonging to selected lines, including line ends 

! second argument is the key to nodes selection: 0 – select only internal nodes 

(default value), 1 –  select all nodes interior to line and at keypoints. 

D,ALL,UX,0 command assigns zero UX displacements for all selected nodes, 

and this corresponds to the symmetry with respect to the axis Oy. In a similar way 

the command D,ALL,UY,0 will set zero displacements UY, which corresponds to 

the symmetry with respect to the axis Ox. 
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We note that in the considered axisymmetric problem, as it can be easily 

checked in ANSYS, the symmetry boundary conditions on the line x = 0 will be 

satisfied automatically, and the above command DL,8„SYMM is provided for 

reliability and is therefore optional. 

2.2) The condition of a rigidly fixed boundary assumes that for the given 

nodes the displacement vector is equal to zero, i. e. in a case of plane problem UX=0 

and UY=0. The corresponding block of commands can be written as: 

D,ALL,UX,0 

D,ALL,UY,0 

Note that in our example problem we use only a constraint on the displacements 

along Oy -axis, i. e. UY=0. 

Finite element model of piezoelectric disk with boundary conditions is shown 

in Fig. 8 (Menu path Plot->Elements, to show boundary conditions select PltCtrls-

>Symbols->and tick “All applied BC”.) 

 

 
Fig. 8 Finite element mesh with boundary conditions 

 

Analysis of results 

The solution results for the finite element problem can be accessed in ANSYS 

via postprocessor. 

Here we provide menu paths for the results that can be reviewed for structural 

analysis (after entering Main Menu). 

В меню ANSYS это можно сделать, используя, например, следующие 

перемещения по меню: 

➢ To display the deformed shape of the structure, select: General Postproc 

→ Plot Results → Deformed shape 

➢ In order to access the results for Degree of freedom solution (solution 

in terms of unknown variables), select: General Postproc → Plot 

Results → Contour Plot → Nodal Solu… → DOF Solution→ 

o X-Component of displacement (distributions of the 

displacements Ux) 

o Y-Component of displacement (distributions of the 

displacements Uy 

o Displacement vector sum (distribution of the displacement 

vector magnitude) 

o Electric potential (distribution of the electric potential) 
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To display the distribution of vector variables, select Vector Plot in General 

Postprocessor: General Postproc → Plot Results → Vector Plot → Predefined 

o DOF solution → Translation U (distribution of the displacement vector) 

o Flux & gradient → Elec field EF (distribution of the electric field 

vector) 

The results of distribution of various components of stresses, strains, electric 

induction vector, etc. can be obtained in General Postprocessor in a similar way.  

 

The program code for solving the example problem in ANSYS ends with the 

command PLNSOL,U,Y which shows the picture of displacement UY distribution 

(Fig. 11). We note that the example problem is axisymmetric in meridional section, 

where Oy-axis corresponds to Oz-axis in 3D, and Ox-axis corresponds to Or-axis. 

Therefore displacement UY is in fact the displacement uz, and displacement UX is 

the displacement ur and so on. 

The main results are shown in Figs. 9-14. The distribution of mechanical and 

electric characteristics is shown for the undeformed shape of the disk. 

 

 
Fig. 9 Deformed shape of piezoelectric disk 

 

 
Fig. 10 Distribution of displacements UX 
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Fig. 11 Distribution of displacements UY 

 

 
Fig. 12 Distribution of displacement vector U 

 

 
Fig. 13 Distribution of electric potential φ 
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Fig. 14 Distribution of electric field vector E 

 

Let us analyse the obtained results from both physical and mathematical 

viewpoints. The difference of potentials ΔV = −2Vinp is applied between the 

electrodes 1 and 2 (i. e. between continuous electrodes in the zone 0 ≤ X ≤ R1) and 

between the electrodes 3 and 4 (i. e. between ring electrodes in the zone R2 ≤ X ≤ 

R). Then we can expect that in the areas between these electrodes an electric field 

will be formed E ∼ ΔV/H = −2Vinp/H = −1000 (V/m), as Vinp = 1 (V), H = 0.002 

(m). The same values of electric fields are indeed can be observed in Fig. 14 (yellow 

vectors). For the zone 0 ≤ X ≤ R1 between continuous electrodes the direction of the 

polarization vector P is opposite to the direction of the generated electric field E. 

Therefore, due to the phenomenon of inverse piezoelectric effect, piezoelectric 

elements in this area should shrink. On the contrary, in the zone R2 ≤ X ≤ R between 

ring electrodes the direction of the polarization vector P coincides with the direction 

of the generated electric field E. Then again, due to the phenomenon of the inverse 

piezoelectric effect, piezoelectric elements in the area R2 ≤ X ≤ R should expand. 

Indeed, such deformations of the zones under the electrodes can be clearly seen in 

Fig. 9. Thus, the expected physics of electromechanical processes in the considered 

problem for a piezoceramic transducer with multielectrode coating is supported by 

the results presented in the figures above. 

It is worth noting that finite element calculations are approximate. Therefore, 

it is necessary to address the question on the accuracy of the obtained results and 

determine the situations in which it is not worth to expect the convergence. In the 

above program code, the characteristics of the finite element mesh were defined in 

the following block of commands: 

 

! Parameters of finite element mesh 

SM=1.00 ! scaling multiplier 

HDIV=8*SM ! Number of elements along the disk thickness 

! (should be even number!) 



 16 

R1DIV=16*SM ! Number of elements along the radial direction from 0 to R1 

R12DIV=32*SM ! Number of elements along the radial direction from R1 to 

R2 

R23DIV=16*SM ! Number of elements along the radial direction from R2 to 

R 

 

Therefore, in order to analyze the convergence, we can perform computations 

with different values of the parameter SM. The results of this computation series are 

presented in the table below. As it can be seen from the table, the maximum values 

of the displacements get stabilized already at SM =0.75 and continue stabilizing 

further with an increase of the parameter SM , i. e. when the sizes of finite elements 

become smaller the values of the displacements almost do not change. Thus, based 

on the data from the table, we can conclude that in order to estimate the maximal 

displacements for this problem it is enough to take SM =0.75. However, already at 

SM =0.25 the relative error in the determination of displacements is less than 3 %, 

which is enough for the majority of practical applications. The value SM =0.25 

means that we take two finite elements (HDIV = 2) along the disk thickness. This 

rather coarse mesh is satisfactory to define the displacements, as the considered 

problem is static and has rather simple geometry, and the elements PLANE223 are 

finite elements with quadratic approximation for each canonic variable. 

 

Table. Data to analyze the convergence of results 

 
 

Meanwhile, as it can be seen from Fig. 14, the electric field vector changes 

significantly in the vicinity of the boundaries of the electrode surfaces (red vectors). 

Data from the talbe shows that, when the mesh density increases, the maximal values 

of the electric field vector magnitude also increase, and we observe no convergence 

for these values. This effect can be expected, as in the electroelasticity problems the 

surface electrodes are the concentrators for various components of the 

electromechanical fields of stresses, strains, electric field intensity and electric 

induction (i. e. for gradient or flow values defined by the derivatives of 

displacements and electric potential). The role of surface electrodes in these 

problems are similar to the roles of the stamps with non-smooth boundaries in 

contact problems. Therefore, as in similar contact problems, in the vicinity of the 

electrode boundaries some components of stresses, strains, electric field intensity 

and electric induction can have root singularities, such as r1/2, where r is the distance 

from the electrode boundary. Naturally, when using conventional isoparametric 

finite elements, we will observe an increase of the values of these fields in the 

vicinity of the electrode boundaries. In practice, it means that specific values of such 

flow variables in a small area near the electrode boundaries do not have much sense, 
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but far away from the electrode boundaries, the convergence will take place. Their 

integral values (for example, the total electric charge) will also converge. 

The idea stated above can be illustrated by a graph (Fig. 15) that shows the 

change of the axial component of the electric field intensity Ez (EF, Y in ANSYS) 

along the radius of the disk on its upper surface (0 ≤ X ≤ R, Y = H/2 in ANSYS). 

This graph can be plotted in ANSYS General Postprocessor by the following 

commands: 

 

! Postprocessor plot of the graphs 

/PLOPTS,INFO,ON 

/COLOR,CURVE,WHIT,1,6 ! color for the graphs - white 

                      ! (will be black after inversion) 

/COLOR,GRID,WHIT, ! color for mesh - white 

                      ! (will be black after inversion)  

/PLOPTS,TITLE,OFF ! no title for the graph 

/PLOPT,FRAME,OFF ! no frame 

/AXLAB,X,r label for the X-axis (r-axis) 

/AXLAB,Y, E_Z ! label for the Y-axis (z-axis) 

/GROPT,DIVX,4 ! Number of divisions along X-axis 

/GROPT,DIVY,4 ! Number of divisions along Y-axis 

/GROPT,DIG2,1 ! Number of digits after decimal point 

 

! Commands to define a path by a number of points 

PATH,XX,4„120 

PPATH,1„0,H/2 

PPATH,2„R1,H/2 

PPATH,3„R2,H/2 

PPATH,4„R,H/2 ! Define a variable E_Z for plotting a graph along the path 

PDEF,E_Z,EF,Y ! Define other variables (if needed) 

PDEF,T_ZZ,S,Y $ PDEF,T_RR,S,X 

PDEF,D_Z,D,Y $ PDEF,D_R,D,X $ PDEF,E_R,EF,X 

PLPATH,E_Z ! Plot a graph of E_Z along the path 
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Fig. 15 Behavior of the Ez-component of the electric field vector on the disk surface 

 

The finite element results presented in Fig. 15 for the dependence Ez = Ez(r) 

are not accurate in the vicinity of the electrode R1 =0.5∙10−2 (m) and R2 =1.5∙10−2 

(m). If, for example, at r < R1 this curve is somewhat similar to a function with a 

root singularity 22
1 rRk − , then a jump of the function at r > R1 is completely 

determined by the error of finite element approximations and the averaging 

techniques adopted here for calculation of the field gradients. However, far away 

from the electrode boundaries the field is determined with sufficient accuracy. 

By analogy we can analyze the behavior of other gradient values of 

electromechanical fields: Er, Dz, Dr, σzz, etc. 

 


